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CM/ECF Version 4.1

2



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP

Password Security Requirements:
 Minimum of 8 characters
 Maximum of 16 characters Maximum of 16 characters
 At least one upper case letter
 At least one lower case letter
 One number or special character (e.g. p ( g

#, $, %, &)
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Password Security
The first time you log in this message appears.
You will need to update your password even if it 
meets the new requirementsmeets the new requirements.
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Menus are now in alphabetical order
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Drop-down navigation menus appear when the 
cursor is over the CM/ECF main menu barcursor is over the CM/ECF main menu bar
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Bankruptcy > Miscellaneous menu

Renamed

No more Adversary events!
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Adversary > Miscellaneous menu

Renamed

No more Bankruptcy events!

8



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP
New Events

Motion to Bar DebtorMotion to Bar Debtor
Motion to Seal Document
Motion to Seal Case
Motion to Unseal Case
Motion to Extend/Limit Exclusivity Period
Motion to Divide Joint Cases for each chapterMotion to Divide Joint Cases for each chapter

9



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP
New Process for Dividing a Joint Case -

Approved by the judges - effective immediately
1. File one of the following motions and pay the fee

2. Submit the proposed order to divide case
3 After the order is granted & the new case is opened:3. After the order is granted & the new case is opened:

file the conversion in the appropriate case
pay the fee, if applicablep y , pp
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• Child Support Creditor (csc:pty)

• United States (us:pty)

• The fee is not charged when a fee due document g
is filed by these party types
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• Child Support Creditor (csc:pty)

• United States (us:pty)• United States (us:pty)

• Failure to select proper party type will incur fees

• If docketing in a case where previous party role• If docketing in a case where previous party role 
type is “creditor” the filer must “create new party” 
and select the new role typeand select the new role type
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The following events have been modified to allow 
Deferred/Not Due/Waived options 

• Adversary Proceeding
• Notice of RemovalNotice of Removal
• Reopen Chapter 11 (Motion)
• Reopen Chapter 12 (Motion)p p ( )
• Reopen Chapter 13 (Motion)
• Reopen Chapter 7 (Motion)p p ( )
• Reopen Chapter 9 (Motion)
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• A new drop down box has been added

• Filers MUST answer the following question to proceed 
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Answering yes pulls up this screen which 
is different than the one in the current 
version of CM/ECF (Version 3.4)
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This screen remains the same

260

This is how the final docket text reads
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Bankruptcy Case Opening

• Out of District is no longer available• Out of District is no longer available
• All counties for the entire country are now available
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- Notice Recipients List will replace the current 

certificate of service language on the court’s local 
forms

- The list will appear as part 2 of the Document Selection 
Menu for notices and orders generated by the court toMenu for notices and orders generated by the court to 
indicate how and who will receive notice
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341 Notices via secure e-mail (no more paper)

• The Bankruptcy Noticing Center (BNC)• The Bankruptcy Noticing Center (BNC)  
sends the debtor’s attorney an e-mail with a 
secure hyperlink to the 341 notice with thesecure hyperlink to the 341 notice with the 
full social security number

• A sample BNC e-mail notification is 
provided at the following web page:
http://ebn.uscourts.gov/documents/Attorney341Email.pdf 
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Certificate of Notice Changes –

Th C tifi t ill i l d ll i i t• The Certificate will now include all recipients 
notified by notices of electronic filing (NEF)

• All parties noticed can be found in one place
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Cost Reduction Efforts–Cost Reduction Efforts

• Proof of Claim Forms will no longer be sent 
with the 341 notices or the Trustee’s Notice ofwith the 341 notices or the Trustee s Notice of 
Possible Dividends

• Creditors will be directed to our web site or 
the Clerk’s Office to obtain the POC form
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Cost Reduction Efforts -
• Attorney for the Debtor will now receive the bypass y yp
notice via e-mail instead of by paper  
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Pay.gov & Lockout issues
• There is no longer a separate pop-up window, a g p p p p ,
panel displays

• Fees MUST be paid via Pay govFees MUST be paid via Pay.gov

• We no longer have the ability to unlock or remove 
a fee due if incurred in errora fee due if incurred in error

• File a motion to request refund

• Once the fees are paid the account is 
automatically unlocked
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Pay.gov now offers the ability to pay via bank 
account debit (ACH) as shown below:account debit (ACH) as shown below:
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Adversary Proceedings:  The attorney filer is now 
automatically added as attorney for the plaintiff.y y

You may add 
co-counsel, if anyco counsel, if any
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Adversary Proceedings: The plaintiff’s attorney will 
not be able to add an attorney for defendant y

The Add attorney
button is gone.
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Adversary Proceedings: The attorney filing the 
complaint is automatically associated and the leadcomplaint is automatically associated and the lead 
attorney text is gone.
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OFOF
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• Selecting “n” to complaint, opens a new “Counsel for” field
Notice of Removal

g p p

• Attorney selects plaintiff or defendant representation
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• If “counsel for: defendant” is selected, the Attorney 
Notice of Removal

, y
button appears for both Plaintiff and Defendant

D f d t’ tt dd th Pl i tiff’• Defendant’s attorney can add the Plaintiff’s 
attorney from the state court proceeding
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• Selecting “Counsel for: plaintiff” automatically 
associates the attorney

• Add additional attorney button displaysAdd additional attorney button displays

• Plaintiff’s attorney cannot add an attorney for the 
defendant

36



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP

Docket text now displays the correct information for 
the notice of removal
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R ll Si l S di ti (RSS)Really Simple Syndication (RSS)
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• All filers have access to the RSS feed 

• Sealed, restricted documents, and private entries will 
not display under the RSS feednot display under the RSS feed

• Refresh to show the most recent 12 hours of activity

• Filers can sort by date or time only or search by key 
word

• This replaces the Activity in My Cases Report
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• Users are NOT charged PACER fees to view the 
feeds

• Clicking a hyperlink to the docket report or aClicking a hyperlink to the docket report or a 
document will incur the standard PACER fees
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• Reports are now limited to a range of 31 days
Searching Reports Using PACER 

• This prevents unintentional requests for a large 
data set which would result in increased PACERdata set, which would result in increased PACER 
fees.

• Check with your bankruptcy/trustee software• Check with your bankruptcy/trustee software 
vendor regarding how this affects your automated 
reportsreports
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• The attorney filing the

Statement of Social Security Number – Privacy Changes

• The attorney filing the 
Statement of Social Security 
Number is now permitted to p
view the image

M lti l t h ld l• Multiple account holders: only 
the account that was used to 
file the statementcan viewfile the statementcan view 
the image

42



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP

• The filer of the SSN and all court staff receive this 
Statement of Social Security Number – Privacy Changes

message when they click on the document before 
they can view it

• Other users receive this message
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New Security Improvements 

Privacy Act – December 1 2003
• Documents filed prior to December 1, 2003 

li it d t t ti i t

Privacy Act December 1, 2003

are limited to court users, case participants 
and someone using the court’s public 
terminalsterminals
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The Trustee’s 341 Filings program has been 

enhanced to include the option to:
• Continue multiple 341 meetings at one time
• Add customized text to each docket entry
• Add standardized text to indicate whether debtor(s) 

appeared
S t b ti ll b• Sort by time as well as case number

• Allow Chapter 13 trustees to use the Trustee’s 341 
Filings programFilings program

• The Trustee’s 341 Filings procedure will be updated 
and sent to all trustees
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The following message now appears reminding you 
to close the window as a security precaution.to close the window as a security precaution.
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• We will no longer set a deficiency for Schedule I, line g y ,
17 and Schedule J, line 19

• When docketing a minimum (skeleton) petition those 
selections are gone
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Search Feature – saves time and incorrect event selections

A complete
word search

A partialp
word search

Two
character or 
word search

50



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP

51



CLERK'S OFFICE WORKSHOPCLERK'S OFFICE WORKSHOP
E-mail Management - Changes

• All 341 notices are moving from paper service 
to secure e-mail service

• After the upgrade check your spam/junk 
folder to ensure you are receiving all e-mailsfolder to ensure you are receiving all e mails
• Setting up folders and rules in your e-mail 
system for efficient management of thesystem for efficient management of the 
increased e-mails
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Outlook Express - File > New > Folder >
E-mail Management – Creating Folders
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From the Outlook Express Create Folder window 
– Enter name of folder and click OK– Enter name of folder and click OK
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Yahoo click folder and enter the ne folder

E-mail Management – Creating Folders
Yahoo – click folder and enter the new folder     
name 
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• All Notices of Electronic Filings (NEF’s):
E-mail Management – Rules Basics

• All Notices of Electronic Filings (NEF s):
• are from cmecfdataquality@nmcourt.fed.us

• contain the following on EVERY subject line:
• Case Number (e.g. 11-10305)( g )
• Chapter (e.g. 7)
• Document Number (e.g. Doc. 1)
• Case Name (e g Keith Partridge)• Case Name (e.g. Keith Partridge)
• Docket Event Name (e.g. Voluntary Petition)
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Outlook Express: Tools > Message Rules > Mail 
E-mail Management – Creating Rules/Filters

p g
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Outlook Express: Make sure you are on the “Mail 
Rules” tab and click New 
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Outlook Express: New Mail Rule 
E-mail Management – Creating Rules/Filters

By selecting the 
condition “Where the 
subject line contains 
specific words, “11-
10305” & the action10305  & the action
“Forward it to people” 
all NEF’s for that case 

i llare automatically sent.
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Yahoo e-mail: Options > Mail Options > 
E-mail Management – Creating Rules/Filters

p p

Filters >Filters >
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Yahoo e-mail: Add Filter > 
E-mail Management – Creating Rules

Set up the parametersSet up the parameters

In this example, 
all e-mail NEF’sall e mail NEF s

for case 
#11-10305 

are sent to myare sent to my 
work folder
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Resources on our website www.nmcourt.fed.us/usbc
The attorney procedures link has been moved to y p
CM/ECF Procedures. This page will be updated frequently.
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Clerk’s Office Resources

Contact the Help Desk for electronic filing p g
questions at (505) 348-2500 (option three)

Contact the Operations Department for caseContact the Operations Department for case 
specific questions at (505) 348-2500 (option zero)

AliveChat is our onlineAliveChat is our online 
instant message service
available on our website

We are available (M-F 8:30 AM to 4:30 PM)
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• New electronic procedures manual will work 
simultaneously with CM/ECF or from our 
website

• Manual provides instructions that will assistManual provides instructions that will assist 
you in filing documents electronically

Ch k th l f tl f d t• Check the manual frequently for updates
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Update on Court Projects
1. Proposed Amendments to the Federal Rules of 

Bankruptcy Procedure – Effective December 1, 2011
2 Release 4 22. Release 4.2
3. Paralegal Outreach
4. E-Orders4. E Orders
5. Filing Agents for Attorneys/Trustees
6. Claims Upload Feature
7. Transition from PDF to PDF/A for CM/ECF Documents
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